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Курсовая работа посвящена решению отдельных вопросов синтеза интеллектуальных алгоритмов управления:

· получение аналогового регулятора-прототипа;

· синтез интеллектуального алгоритма управления на базе аналогового прототипа с применением стандартных пакетов MatLab;

· сравнительный анализ работы полученных регуляторов.

Форма представления результатов выполнения ККР: расчетно-пояснительная записка объемом 20 – 25 страниц должна включать в себя постановку задачи, описание метода ее решения, описание алгоритмов и программ, используемых для синтеза регуляторов, сравнительный анализ полученных результатов.

II. ЗАДАНИЕ

Задана структурная схема нескорректированной системы управления (рис.1.а) и скорректированной (рис.1.б).
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Рис.1.

Исходные данные:

Параметры объекта управления, входного сигнала и исходные требования (по точности, быстродействию), метод логического вывода определяются вариантом задания, который выдается преподавателем.

Максимальное значение сигнала, воздействующего на объект управления  ± 27В.

Варианты задания по указанным пунктам представлены в таблицах 1.1-1.6.
Таблица 1.1.
	№
	Тип объекта управления
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Таблица 1.2.
	№
	Входной сигнал

	1
	А0

	2
	А0+А1*t

	3
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Таблица 1.3.

	Таблица параметров сигналов

	№
	А0
	А1

1/с
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	1
	0,1
	0,05
	0,5
	0,1
	0,01

	2
	0,01
	0,1
	1,0
	0,05
	0,05

	3
	0,2
	1,0
	0,8
	0,1
	0,02

	4
	0,5
	0,5
	0,1
	0,2
	0,03

	5
	1,0
	0,1
	0,2
	0,2
	0,02


Таблица 1.4.

	Таблица параметров объекта управления

	

	№
	Т

с
	Т1

с
	Т2

с
	Т3

с
	Коу



	1
	0,02
	0,4
	0,2
	0,1
	2,0

	2
	0,01
	0,1
	0,07
	0,04
	1,0

	3
	0,002
	0,015
	0,007
	0,006
	2,0

	4
	0,001
	0,02
	0,008
	0,003
	10,0

	5
	0,0005
	0,018
	0,004
	0,001
	5,0


Требуется:

1) построить z-передаточную функцию приведенной непрерывной части;
2) рассчитать параметры переходной матрицы объекта управления;

3) синтезировать алгоритм коррекции исходя из заданных требований динамической точности;
4) рассчитать переходные процессы в системе после коррекции; (*)

5) Выполнить программно-аппаратную реализацию  корректирующего звена с использованием выбранного микроконтроллера.
Таблица 2. Таблица индивидуальных заданий контрольно-курсовой работы.

	№
	Фамилия И.О.
	ТипОУ
	Тип входного сигнала
	Тип динамического фильтра
	Метод логического вывода
	Входной сигнал
	Набор параме-тров


	1
	
	
	
	
	
	
	

	2
	
	
	
	
	
	
	

	3
	
	
	
	
	
	
	

	4
	
	
	
	
	
	
	

	5
	
	
	
	
	
	
	

	6
	
	
	
	
	
	
	

	7
	
	
	
	
	
	
	

	8
	
	
	
	
	
	
	

	9
	
	
	
	
	
	
	

	10
	
	
	
	
	
	
	

	11
	
	
	
	
	
	
	

	12
	
	
	
	
	
	
	

	13
	
	
	
	
	
	
	

	14
	
	
	
	
	
	
	

	15
	
	
	
	
	
	
	

	16
	
	
	
	
	
	
	

	17
	
	
	
	
	
	
	

	18
	
	
	
	
	
	
	

	19
	
	
	
	
	
	
	

	20
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	


ЭТАПЫ  ВЫПОЛНЕНИЯ ЗАДАНИЯ

1. Формирование задания в соответствии с конкретным вариантом задания.

2. Нахождение передаточной функции приведенной непрерывной части объекта управления (ОУ).

3. Выбор величины такта квантования.

4. Определение   передаточной функции динамичекого фильтра в соответствии с заданием.

5. Определение лингвистических переменных используемых для формирования управляющего воздействия.
5.1. Определение набора термов лингвистических переменных.

5.2. Определение диапазона значений термов лингвистических переменных.

5.3. Определение функций принадлежности для термов лингвистических перемнных.

6. Определения алгоритма логического вывода.

7. Формирование блока правил вывода лингвистических значений выходной переменной.

8. Определение алгоритмов фаззификации и дефаззификации.

9. Формирование модели динамической системы в среде SimuLink.

10. Построение алгоритма работы цифрового вычислительного устройства в реальном времени.

11. Расчет переходных процессов в скорректированной системе, при подаче на вход сигнала с амплитудой единичной ступеньки. (*).

12. Оформление отчета по ККР.

(Отчет должен содержать описание всех перечисленных выше пунктов).
(*) пункт рекомендуется выполнять с помощью системы моделирования SimuLink.
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3. Исходные данные для ККР:

· Определяются заданным номером варианта ККР

4. Пояснительная записка должна включать разделы:

· Формирование задания в соответствии с конкретным вариантом задания.

· Нахождение передаточной функции приведенной непрерывной части объекта управления (ОУ).

· Выбор величины такта квантования.

· Определение   передаточной функции динамичекого фильтра в соответствии с заданием.

· Определение лингвистических переменных используемых для формирования управляющего воздействия.

· Определение набора термов лингвистических переменных.

· Определение диапазона значений термов лингвистических переменных.

· Определение функций принадлежности для термов лингвистических перемнных.

· Определения алгоритма логического вывода.

· Формирование блока правил вывода лингвистических значений выходной переменной.

· Определение алгоритмов фаззификации и дефаззификации.

· Формирование модели динамической системы в среде SimuLink.

· Построение алгоритма работы цифрового вычислительного устройства в реальном времени.

5. Перечень графического материала: Структурная схема системы интеллектуального управления, блок схема программы, реализующий синтезированный алгоритм, схема моделирования в среде  SimuLink, расчетные переходные процессы в скорректированной системе  – листы формата А4.
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                                                                   (подпись,дата)

Задание принято 

к исполнению      _____________________/_____________

                                                                   (подпись,дата)

IV. КРАТКИЕ ТЕОРЕТИЧЕСКИЕ СВЕДЕНИЯ

В качестве предпосылок к применению нечетких регуляторов обычно называются:

- большое число входных параметров, подлежащих анализу (оценке);

- большое число управляющих воздействий (многомерность);

- сильные возмущения;

- нелинейности;

- неточности математических моделей программы регулирования;

- возможность использования технических знаний "know - how". 
Синтез нечеткого регулятора

Для создания нечеткого регулятора в системе Matlab необходимо открыть соответствующий редактор (FIS editor), введя в командной строке команду:

>> fuzzy
В результате выполнения данной команды на экране открывается окно FIS-редактора (рис. 2):
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Рис. 2.
При формировании нечеткого регулятора необходимо в первую очередь определить его тип, в  нашем случае - Сугено нулевого порядка. Создаем новый регулятор типа Сугено командой меню: 

File -> New FIS -> Sugeno
Учитывая, что исходя в исходных данных определены две входные переменные, добавляем еще одну входную переменную в формируемый нечеткий регулятор:

Edit -> Add Variable -> Input
Далее следует установить имена для входных переменных, отображаемых на панели нечеткого регулятора (рис. 3).
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Рис. 3.

Открываем редактор функций принадлежности:

Edit -> Membership Functions
С помощью редактора функций принадлежности определяем имена и параметры функций принадлежности, а также редактируем границы изменения входных переменных.

Для переменной «ошибка» сначала определяем границы термов «нулевая» и «положительная малая» и «положительная большая»:

Z =  [-0.3 0 0.3]

PS =  [0 0.3 0.6]

PL =  [0.3 0.6 3.297 4.553]

Аналогично определяем симметричные им отрицательные значения лингвистической переменной «ошибка» (рис. 4).
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Рис. 4.

Для переменной «скорость» аналогично определяем терм-множество значений:  Z = [-10 0 10]; PS = [0 10 20]; PL =  [10 20 42 58] и симметричные им отрицательные значения (рис. 5).
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Рис. 5.

Значения выходной переменной для регулятора Сугено определяем в виде пяти констант nUL, nUS, U0, US, UL (nUL = -27, nUS = -13) (рис. 6).
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Рис. 6.

Далее необходимо сформировать базу знаний, представляющую собой правила вывода. С этой целью открываем редактор правил:

Edit -> Rules
и задаем 13 правил определенных в таблице ранее (рис. 7).
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Рис. 7.

Сформированный таким образом нечеткий регулятор необходимо сохранить в файле текущего раздела.  С этой целью выполняем  в командном окне следующую последовательность команд:

File -> Export -> To File
После сохранения нечеткого регулятора в файле его необходимо экспортировать (перенести) в рабочее пространство -  Workspace:

File -> Export -> To Workspace
Таким образом нечеткий регулятор сформирован и готов к использованию в рабочей модели следящего привода. Для включения нечеткого регулятора в модель ЭСП, необходимо перенести из библиотеки Fuzzy Logic Toolbox соответствующую пиктограмму «Fuzzy Logic Controller» в область модели, выполнив при этом необходимые коммутации (рис. 8 и рис. 9).
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Рис. 8.
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Рис. 9.

Для включения разработанного нечеткого регулятора необходимо в параметрах модуля «Fuzzy Logic Controller» указать имя, которое было присвоено регулятору при экспортировании его в Workspace (рис. 10).
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Рис. 10.

Для оценки характеристик привода с нечетким регулятором, проведем расчет переходных процессов при  отработке входного сигнала (ступеньки) в 1 рад. Переходные характеристики ЭСП с синтезированным регулятором показаны на рис.11 (а) и (б).
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Рис. 11а,                                                  Рис. 11б

Анализ переходных процессов в ЭСП с синтезированным нечетким регулятором позволяет сделать вывод о том, что переходный процесс значительно затянут, причем очевидно, что причиной этого является пульсация  управляющего напряжения от +27В до 0 на начальном этапе управления (рис. 12). 
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Рис. 12.

Причиной возникновения пульсаций управляющего напряжения на начальном участке отработки входного воздействия является недостаточное количество правил, определяющих выходное напряжение в зависимости от значений входных сигналов.

Пульсации начинаются при достижении двигателем скорости 10рад/с при еще большой ошибке, поскольку для указанных значений переменных «ошибка» и «скорость» не заданы правила,  выход регулятора в этом случае принимает нулевое значение. 

Для устранения этого недостатка добавим в блок правил следующие правила:

- если «ошибка» положительная большая, то управление положительное большое при любом значении скорости.
- если «ошибка» отрицательная большая, то управление отрицательное большое при любом значении скорости.

Дополненный блок правил будет иметь вид, представленный в таблице (таблица 4).

Таблица 4

	
	ошибка

	скорость
	
	NL
	NS
	Z
	PS
	PL

	
	NL
	-UL
	
	UL
	
	UL

	
	NS
	-UL
	U0
	US
	UL
	UL

	
	Z
	-UL
	-US
	U0
	US
	UL

	
	PS
	-UL
	-UL
	-US
	U0
	UL

	
	PL
	-UL
	
	-UL
	
	UL


Расчетные характеристики ЭСП с модифицированным нечетким регулятором представлены на рис. 13.
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Рис. 13а.                                   Рис. 13б

Диаграмма изменения управляющего воздействия приведена на рис. 14.
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Рис. 14.

Сравнительный анализ переходных процессов свидетельствует о том, что получены значительно лучшие характеристики, однако видно, что при уменьшении ошибки, скорость сбрасывается слишком быстро, из-за этого переходный процесс по прежнему остается затянутым.
Для коррекции этого исправим в блоке правил два правила, соответствующие указанной ситуации в сторону увеличения уровня управляющего напряжения (таблица 5):

Таблица 5

	
	ошибка

	скорость
	
	NL
	NS
	Z
	PS
	PL

	
	NL
	-UL
	
	UL
	
	UL

	
	NS
	-UL
	-US
	US
	UL
	UL

	
	Z
	-UL
	-US
	U0
	US
	UL

	
	PS
	-UL
	-UL
	-US
	US
	UL

	
	PL
	-UL
	
	-UL
	
	UL


Итоговые переходные процессы имеют вид, представленный на рис. 15.
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Рис. 15(а)                                           Рис. 15(б)

Диаграмма изменения управляющего сигнала представлена на рис. 16.
[image: image29.png]



Рис. 16.

Анализ переходных процессов позволяет сделать вывод о том, что сформированная система управления с нечетким регулятором обеспечивает переходные процессы при отработке больших углов рассогласования, близкие к оптимальным по быстродействию. Вид итоговой поверхности, формирующей управляющее воздействие в зависимости от состояния объекта управления представлен на рис. 17.
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Рис. 17.
Создание и обучение нейронечеткого регулятора
В системе MatLab реализован ANFIS-редактор, который позволяет с помощью нейронечеткого описания автоматически синтезировать из экспериментальных данных нечеткие правила. Сеть ANFIS описывает систему нечеткого логического вывода типа Сугено. Параметры сети после обучения настраиваются так, чтобы минимизировать отклонения между результатами моделирования и экспериментальными данными.

Загрузка ANFIS-редактора осуществляется по команде 

>>anfisedit
Графическое окно AnfisEditorпоказано на рис. 18.
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Рис. 18.
В центре окна изображена область визуализации. В этой области выводится два типа информации:

- при обучении системы – график зависимости ошибки обучения от порядкового номера итерации;

- при загрузке данных и тестировании системы – экспериментальные данные и результаты моделирования. При этом по оси абсцисс откладывается порядковый номер строчки данных в выборке (обучающей, тестирующей или контрольной), а по оси ординат – значение выходной переменной для данной строчки выборки. Используются следующие символы: голубая точка (.) – тесирующая выборка; голубая окружность (о) – обучающая выборка; голубой плюс (+) – контрольная выборка; красная звездочка (*) – результаты моделирования.

Правее области визуализации  находится область свойств ANFISinfo.

В области свойств выводится информация о количестве входных и выходных переменных, о количестве функций принадлежностей для для каждой входной переменной, а также о количестве строчек в выборках.

В этой области расположены две кнопки: Structureи ClearPlot.

Нажатие кнопки Structureоткрывает новое графическое окно, в котором система нечеткого логического вывода представляется в виде нейро-нечеткой сети. Количество входов этой сети зависит от числа столбцов обучающей выборки. Количество нейронов – 2-4 слоя соответствует количеству правил.

На рис. 19. показан пример сети ANFIS, в которой две входные переменные (для описания каждой использовано по три терма) и восемь правил. Количество правил зависит от выбора параметров в области GenerateFIS.
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Рис. 19.
Нажатие кнопки  ClearPlot позволяет очистить область визуализации.

В области загрузки данных LoadDataрасположены:

- Type - меню выбора типа данных; Traning - обучающая выборка; Testing - тестирующая выборка; Checking - контрольная выборка; Demo - демонстрационный пример;

- From - меню выбора источника данных: Disk–диск; Worksp. – рабочая область MatLab;

- LoadData – кнопка загрузки данных;

-ClearData - кнопка очистки данных.

В течение одного сеанса работы ANFIS - редактора следует загружать данные одного формата, т.е. количество входных переменных в выборках должно быть одинаковым.

GenerateFIS – меню создания исходной системы нечеткого логического вывода, содержащее альтернативы:

- Loadfromdisk – загрузка существующей системы с диска;

- Loadfromworksp. – загрузка системы из рабочей области MatLab;

- генерирование описания входных переменных по методу решетки (без кластеризации);

- Sub. Clustering – генерирование по методу субкластеризации.

В области также расположена кнопка Generate, по нажатию которой генерируется исходная система нечеткого логического вывода.

При выборе Gridpartition появляется окно ввода параметров метода решетки (рис. 20), в котором нужно указать количество термов для каждой входной переменной и тип функции принадлежности для входных и выходной переменных.

Таким образом, при выборе метода решетки выполняется нечеткое разбиение базовых шкал входных переменных. Настройка параметров термов не требуется, а количество правил равно произведению мощностей терм-множеств лингвистических переменных, описывающих посылки (см. рис. 20).
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Рис. 20
 При выборе Sub.clustering появляется окно ввода следующих параметров метода субкластеризации (рис. 21).
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Рис. 21.

На рис. 21 обозначены:

Range of influence– уровни влияния входных переменных;

Squash factor– коэффициент подавления;

Accept ratio – коэффициент, устанавливающий во сколько раз потенциал данной точки должен быть выше потенциала центра первого кластера для того, чтобы центром одного из кластеров была назначена рассматриваемая точка.
Reject ratio – коэффициент, устанавливающий во сколько раз потенциал данной точки должен быть ниже потенциала центра первого кластера, чтобы рассматриваемая точка была исключена из возможных центров кластеров.

Область обучения (Train FIS) содержит меню выбора метода оптимизации (Optim. method), поле задания требуемой точности обучения (Error tolerance), поле задания количества итераций обучения (Epochs) и кнопка Train Now, нажатие которой запускает режим обучения. Промежуточные результаты обучения выводятся в область визуализации и в рабочую область MatLab. В ANFIS - редакторе реализованы два метода обучения:

- Backpropa - метод обратного распространения ошибки, основанный на идеях метода наискорейшего спуска;

- Hybrid - гибридный метод, объединяющий метод обратного распространения ошибки с методом наименьших квадратов.

В области тестирования (Test FIS) расположены меню выбора выборки и кнопка Test Now, при нажатии которой происходит тестирование нечеткой системы с выводом результатов в область визуализации.

В качестве примера рассмотрим динамический объект, передаточная функция которого имеет вид (рис. 22):
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Рис.22
SimuLink- модель для расчета динамических характеристик объекта (рис. 23)
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Рис.23.
Подача на объект случайного сигнала и снятие тестовых характеристик для последующего обучения нейроэмулятора (рис.24).
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Рис. 24
Загрузка полученных данных в редактор Anfis (вызывается командой anfisedit в командной строке Matlab) (рис. 25):
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Рис. 25.

Генерация нечеткого регулятора (GenerateFIS) (рис. 26):
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Рис. 26
Обучение контроллера (Trainnow), тестирование (TestFIS) и экспорт обученного контроллера в WorkSpace (рис. 27).
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Рис. 27.

Проверка работы обученного нейроконтроллера (рис. 28- 29).
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Рис. 28.
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Рис. 29.
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